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Setting up a Wiki 
 
Why set up a “wiki”? 
 
A wiki can allow you, your colleagues and students to rapidly create and collaborate on any project. 
This is also an excellent way to develop the writing skills of students. It is a tool that can allow 
disparate groups of people to work towards a common goal without resorting to endless emails and 
telephone calls. 
 
Wikis are like web pages that anyone can create and edit. Individuals that are members of that 
wiki’s editing team can add and remove elements such as text, images, links, and other media 
elements. Members can also alter the look and feel of the page. You can generate discussions and 
provide opportunities for problem based learning experiences. 
 
You can explore and learn more about why it is useful to set up an educational wiki by following 
these links: 
 
Educause: 7 things you should know about wikis. 
 

http://www.educause.edu/ELI/7ThingsYouShouldKnowAboutWikis/156807 
 
How to set up wikis 
 

http://aquaculturepda.wikispaces.com/Wikis 
 
Web 2.0 Wikis 
 

http://web2tutorial.wikispaces.com/wikis 
 
Wikis in plain English 
 

http://www.commoncraft.com/video-wikis-plain-english 
 
Where can I start? 
 
There are several companies that allow you to easily set up a blog. Some are free while others are 
not. Here are two that cater for educators. 

 
Wikispaces for teachers. 
“Wikispaces is a great place for 
teachers, students, and educators to 
work together. We're committed to 
helping educators, so Wikispaces for 
K-12 education use is completely 
free, and free of advertising.” 

 

 
 

http://www.wikispaces.com/site/for/teachers 
   
PBWorks. “Use a wiki for easy web 
pages that let you collaborate. If 
you're looking for an easy way to get 
your syllabus online and a tool to let 
your students collaborate online, 
PBWorks is for you. No more IT 
headaches. No more worries about 
safety.” This tool was formally known 
as PBWiki. It recently underwent a 
name change. 

 

 
 

http://pbworks.com/academic.wiki 
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Setting up a Wiki 
 
For this exercise the PBWorks software will be utilised. Open a web browser such as Internet 
Explorer and type this url in the address bar. 
 

http://pbworks.com/ 
Your browser will take you to this page. 
 

 
 
Click on the Academic Solutions link at the lower right corner of the page. You will be taken to 
this page. 
 

 
 
Click on the Try It Now button to choose the type of wiki you wish to establish. 
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For this activity select Basic and click on the Select button. 
 

 
 
The following screen will appear. 
 

 
 
 
Create a name and type for your wiki. The name for your wiki will form the Internet address of 
your wiki. Ensure that you select an appropriate, functional and easily remembered title. 
 
Create your account by entering your name, email address and a password. Click on Next. 
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The following screen will appear. You can determine who has access to your wiki. You can also 
choose who can edit the wiki. Agree to the terms of service and click on the “Take me to the wiki”. 
 

 
 
You will be taken to your new wiki. It will have a single page that you can begin editing. 
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Creating and editing your wiki  
 
Your first wiki page will look similar to the screen shown at the foot of this page. There are some 
important features to note. 
 
Home button: You can always return to the opening page of your wiki by clicking on the Home 
button that is situated alongside the title of your wiki. 
 
View Tab: You can click on the View tab to see the wiki page, as it will appear to readers of your 
wiki. 
 
Edit Tab: You can click on the Edit tab to make changes to the wiki page using an editor. 
 
Create a page: You can create a new wiki page. 
 
Upload Files: You can perform multiple uploads to add files to your wiki. You can also manage the 
files. 
 
Front page: Clicking on this link will take you to the home page. 
 
Pages & files: You can manage pages in your wiki site, including the Sidebar that is used for 
navigation from one page in your wiki to another page. 
 
Settings: This is an important part of the wiki. You can change the name of the wiki, its colour 
theme, amend security settings, set up an RSS feed, and add users. 
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Uploading Files 
 
When creating a wiki it is a good idea to gather your resources together beforehand. You may have 
created a text file with some information, saved some bookmarks for a number of web sites and 
created a folder of images. 
 
It is a good idea to upload your files at the beginning of the project. Have you already resized your 
images? It is wise to resize your images to dimensions such as 640 x 480 pixels or smaller. 
 
Select Upload files from the list of options on the upper right hand side of the window when you 
are in View mode. The following window will appear. This page already has a number of files that 
have been uploaded. 
 

 
 
To upload files click on the Upload Files located second from the upper left on the page. A dialog 
box will appear that will allow you to browse through the folders and files of your computer. It may 
look similar to the window below. You can select multiple files and perform a batch upload. You 
can select a maximum of ten files. 
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If you attempt to upload more than ten files the following alert will appear. 
 

 
 
Click OK and then the following pane will appear. 
 

 
 
Click Cancel Uploads or click the Close button in the upper right hand corner and start again. 
 
Once you have selected your images click on the Select button and the batch upload process will 
begin. A window similar to the one below will appear. A progress bar will appear for each upload. 
 

 
 
The uploaded files will appear in your Uploads window and will be available for use in building 
your wiki web site. 
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Editing your home page 
 
 
You can begin editing your home page by clicking on the Edit Tab. The following screen will 
appear. You are now in Edit mode. Notice how the window has changed. 
 

 
 
As you can see a toolbar will appear that will allow you to perform many of the functions of a 
conventional text editor. You can edit this new page as you would a word document for example. 
You can alter the font, format the text, and add elements such as tables and rules. You can also 
embed images and other media elements. 
 
Look closely at the toolbar below. 
 

 
 
As you can see you can alter the style, font, size, colour, justification and background colour for the 
text. You can also insert images, tables, rules and plugins (video, media, etc). 
 
The best way to become skilful in the art of formatting a wiki page is to simply experiment. Let’s 
explore a few possibilities. 
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Inserting a table 
 
You can insert a table into the wiki page by clicking on the Table button on the toolbar.  
 

 
 
The following window will appear. 
 

 
 
You can set the numbers of rows, columns as well as specify the dimensions of the table. You can 
even give the table a heading by entering a caption. 
 
Changing the properties of a table 
 
If your right mouse click on a table on the wiki page the following popup contextual menu will 
appear. 
 

 

 
 
As you can see you can alter a number of the table’s properties quite quickly using this feature. 
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Inserting a plugin 
 
PBWorks allows you to insert a number of dynamic plug-ins. The best way to learn about the 
possibilities is to explore this feature. Click on the Insert Plugin button on the toolbar. The 
following window will appear. 
 

 
 
Right mouse click on each button to see the possibilities available to you. 
 

 
 
 

 
 

 

 
 
It is worthwhile to explore the inclusion of slideshows, equations, contents, video and even 
interactive elements such as spreadsheets and chat spaces. 
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Inserting an image 
 
You can insert an image into the wiki page by selecting the Images and Files tab from the section 
located in the right hand sidebar. The following list, showing images uploaded earlier will appear. 
As well, at the foot of the list of images will be a link to a window that allows you “Insert image 
from URL”. 
 

 

 

 
You can drag and drop one of the listed images onto the editing window. Once the image is in pace 
you can select it and position it using the left, right and centre justification tools.  If you right mouse 
click on the image a popup menu will appear that will allow you to modify the image. 
 
If you select the Image Properties item the following window will appear.  
 

 
 
You can modify the images dimensions, spacing, alignment and add a border. 
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Create a new page 
 
Click on the Create a new page on the right hand side of the screen. The following screen will 
appear 

 

 
 

You can either choose to start from a blank page or try one of the tailored templates. Click on the 
Create new page button. The following screen will appear. 
 

 



http://www.larkin.net.au/ Page 13 
 

 Some rights reserved   http://creativecommons.org/licenses/by-nc-sa/3.0/ 
 

Managing files and folders 
 
One can manage files and folders within a wiki.  
 
You can add folders by following these steps. 
 

1. Click on the Home button. 
2. Click on the Pages and Files link on the right hand side  
3. The following screen will appear. 

 

 
 
Create a new folder by clicking on the add button and give it a suitable title such as Pages, for 
example. Create a second folder and name it Images 
 

 
 
Click on the Unfiled Items menu item. Select the images in the list by clicking on the selection 
buttons and then click on the Move button. Move the images to the Images folder. 
 
Click on the Unfiled Items menu item. Select the pages in the list by clicking on the selection 
buttons and then click on the Move button. Move the pages to the Pages folder. 
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Navigation 
 
You can set up navigation to the wiki by adding a set of links to the various pages in the Sidebar. 
Follow these steps. 
 
One can manage files and folders within a wiki.  
 
You can add folders by following these steps. 
 

1. Click on the Home button. 
2. Click on the Pages and Files link on the right hand side  
3. The following screen will appear. 

 

 
 
Click on the Sidebar page listing. The following screen will appear. 
 

 
 
Click on the Edit tab. 
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Delete the sample text and the edited Sidebar should appear as follows. 
 

 
 
Select the Pages tab in the Insert links panel on the right hand side of the page. See below. 
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Click on the pages listed there that you wish to appear in the Sidebar. In this example you would 
click on Front Page and Course Plan. The links should pop into the Sidebar editing window as 
follows. 
 
You should NOT select SideBar and add it as a navigation link as you will create problems if you 
link to it recursively. You should not embed large images or other media in the SideBar as well. 
 

 
 

Once you have added the links to the pages in your wiki and also edited the name of the links as 
appropriate click on the Save button. The SideBar ‘page’ should appear as follows. 
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The sidebar will appear as follows to a viewer or reader of your wiki. Users can explore your wiki 
via the Sidebar. The Navigator will allow users to explore all areas. 
 

 
 
Settings 
 
It is wise to explore the settings to see which changes you would like to make to the look and feel 
of the wiki.  
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You can add members but before you can do so make sure that you have created a PBWorks 
Identity by adding their email address and clicking Add User and determining their access level. 
 

 
 

 
 
You can also add multiple numbers of users by clicking on the create accounts for your students. 
You will need to follow a number of steps as shown below. 
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